
Modifying Microsoft Word Templates for
TestTrack Requirement Document Exports

Note: This information only applies to TestTrack 2015.1 and earlier. See the Helix ALM help for
information about exporting items toWord in Helix ALM (or TestTrack 2016 - 2016.1).

You can export requirement documents from TestTrack toMicrosoft Word if you need to provide the
document in a format to comply with your company’s or another organization’s standards, or if you need to
share the document with others who do not have TestTrack access.

Exported documents use aWord template to format the resulting document. TestTrack includes templates
with various formats. If your exported documents need to have different formatting or information, you can
modify one of the installed templates.

How requirement documents are exported

The content and appearance of a TestTrack requirement document exported toWord is controlled by the
information displayed in the document and theWord template you use for the export.

The templates installed with TestTrack containWord bookmarks, which are placeholders for exported
information. When a document is exported, the bookmarks are replaced with the requirement and document
informationmapped to them. The templates also include styles that control the text formatting. You can use
one of theWord templates installed with TestTrack as is or modify it. If you are going tomodify a template, it
is highly recommended that you have experience working with styles inWord.

How to choose and modify a template

Perform the following steps to choose andmodify aWord template for your exported documents.

1. Display the information you want to export in the document in TestTrack.

2. Perform a test export using eachWord template installed with TestTrack. Compare the exported
documents to determine which templatemost closely matches how you want your exportedWord
documents to look.

3. Tomodify the template, change the styles, bookmarks, table of contents, cover page, and footers to
match the output you want.

4. Export a document using your modified template to preview the changes. Continuemodifying and
previewing until the exported document meets your needs.

5. Save theWord template for future use.

Display the information to export in TestTrack
Before you export a document, make sure only the information you want to include is displayed in the
TestTrack document (Document View in the Specification Document window). You can add or remove
columns or filter requirements to export specific information.
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n Text and images in the requirement Description field are exported exactly as you see them.

n Information from the document Snapshots tab is also exported unless the corresponding bookmark is
removed from theWord template used for the export.

To save the document view to use it for future exports, chooseView > Save As View. To apply the saved
view, open the document and chooseView > Apply View.

Choose a template
After the document is displayed the way you want to export it, choose aWord template to use for exports. To
preview the installed templates and determine which onemost closely matches the look you want for your
exported documents, export the document using each of the installedWord templates.

To export the document, make sure the document is open and choose File > Export > Microsoft Word
Export.
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Next, click Browse to select a template. Templates are stored in the templates subdirectory in the TestTrack
application directory (e.g., C:\Program Files\Seapine\TestTrack\templates). The following templates are
available.

Template Description

BasicIndented.doc Indents requirements to display up to nine levels of the document hierarchy.
Includes a cover page, table of contents, and footer.

BasicIndentedColor.doc Same as BasicIndented.doc but uses blue text for the title, section headers,
and requirement headings.

BasicLeftAligned.doc Left-aligns all requirements. Includes a cover page, table of contents, and
footer.

Plain.doc Left-aligns all requirements. Does not include a cover page or table of contents.

Save the exported document with a unique filename that indicates the template you are using, such as
TestExportBasicIndentedColor.doc. Repeat the export for each template, saving each file with a different
name. Open each exportedWord document to preview it and decide which template to use.

Modify the template
If your exported documents need to use different formatting or include different information, modify a copy of
the template closest to the appearance and content you need. Open the template inWord and save it with a
unique filename. It is important to distinguish your modified template from the installed templates to avoid
overwriting any changes when you upgrade or reinstall TestTrack.

You canmodify the bookmarks, styles, and other parts of the template to change the exported document
content and appearance. At this point, you have two files to work with: the template file you just saved and the
test export file you used previously. We recommend viewing these files side-by-side as youmodify your
template. You can preview and fine tune changes in the test file and then copy and save the changes in the
template file. This will help youmodify the template without adding unnecessary content or deleting the
required bookmarks.

Note: The following information applies tomodifying templates inWord 2010. Refer to theWord help if
you use a different version.

Bookmarks

Bookmarks are placeholders for requirement and document information in theWord template. When a
document is exported, information is populated in the resulting document based on the location of the
corresponding bookmark in the template.

To view bookmarks in the template, choose File > Options and click theAdvanced category. Select Show
bookmarks in the Show document content area and click OK. I-beams are used to indicate a bookmark.
When a document is exported, text that replaces a bookmark is displayed in square brackets.
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The following bookmarks are included in the installedWord templates.

Bookmark Templates
included in

Replaced with: Used:

MICROSOFT_
WORD_
EXPORT_
TEST_
TRACK_RM

All All requirements displayed
in the document

After all front matter

MICROSOFT_
WORD_
EXPORT_
TEST_
TRACK_TITLE

BasicIndented,
BasicIndentedColor,
and
BasicLeftAligned

Document Name field value On the cover page

MWE_TEST_
TRACK_
RMDOC_
DESCRIPTION

All Document Description field
value

After the Description: text on the
cover page

MWE_TEST_
TRACK_
RMDOC_
NAME

Plain Document Name field value After the Name: text on the first
page

MWE_TEST_
TRACK_
RMDOC_
SNAPSHOT_
HISTORY

All A table of information from
the document Snapshots
tab, including the snapshot
number, Created By,
Created Date, Label, and
Comment field values

In the Snapshot History section
after the cover page in the
BasicIndented,
BasicIndentedColor, and
BasicLeftAligned templates and
on the first page in the Plain
template
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Bookmark Templates
included in

Replaced with: Used:

MWE_TEST_
TRACK_
RMDOC_
SNAPSHOT_
VERSION

All Document snapshot version
number and label based on
the version displayed in
document

After the Snapshot Version: text
on the cover page

MWE_TEST_
TRACK_
RMDOC_
STATUS

All Document status After the Status: text on the
cover page

To view a bookmark name, select an indicator, click the Insert tab, and click Bookmark. The Bookmark
dialog box opens, which you can use to add bookmarks not included in the template or delete bookmarks.
Only delete bookmarks if you do not want to include the corresponding information in the exported document.

Styles

Styles are used to format text inWord documents. The templates installed with TestTrack have several
paragraph and character styles that are used to automatically format exported information and other static
text. See Paragraph styles, page 11 and Character styles, page 13 for information about styles used in the
templates.

You canmodify the styles if you want to change text properties, such as font, color, size, and spacing.

Use the Styles window to view the styles in a template. To open the Styles window, click theHome tab and
click the arrow in the bottom right corner of the Styles area.

Youmay want to use the Style Inspector to quickly view the styles applied to text. In the test export file, open
the Styles window and click . The Style Inspector pane opens and displays the style applied to selected
text.
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You canmodify styles from the Style Inspector or Styles window. Mouse over the style you want to change,
click , and chooseModify. You can change the style properties to use the formatting you want, but do not
rename or remove any styles because they are automatically mapped to format exported requirement and
document information.

Some styles are based on other styles tomaintain consistent formatting. If you change a style, any styles
based on it are also automatically updated. For example, the Requirement Level 2 style is based on the
Requirement Level 1 style. Any formatting changes made to Requirement Level 1 are also applied to
Requirement Level 2 and any other styles based on it.
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Cover page

All installed templates have a separate cover page except the Plain template. The same information from the
cover page in the other templates is included on the first page of the Plain template, but there are no section or
page breaks before the snapshot history information.

The following information is included on the cover page.

Component Templates
included in

Populated by: Style used

Name Plain Document Name field value replaces the
MWE_TEST_TRACK_RMDOC_NAME
bookmark.

Requirement
Document Name
character style

Title BasicIndented,
BasicIndentedColor,
and
BasicLeftAligned

Document Name field value replaces the
MICROSOFT_WORD_EXPORT_TEST_
TRACK_ TITLE bookmark.

Requirement
Document Title
paragraph style

Description All Document Description field value replaces the
MWE_TEST_TRACK_RMDOC_
DESCRIPTION bookmark.

Requirement
Document
Description
paragraph style

Authors All ‘Enter the document author names’ is static text
that needs to be replaced after each export.

Requirement
Field character
style
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Component Templates
included in

Populated by: Style used

Snapshot
Version

All Snapshot version number replaces theMWE_
TEST_TRACK_RMDOC_SNAPSHOT_
VERSION bookmark.

Displays <Current Version> if the exported
document is the current version.

Requirement
Document
Snapshot
Version
character style

Status All Document Status field value replaces the
MWE_TEST_TRACK_RMDOC_STATUS
bookmark.

Requirement
Document
Status character
style

Last
Modified
Date

All The date theWord document was generated
replaces aWord field code. The date can be
manually changed, but dates cannot be
retrieved from TestTrack.

Requirement
Field character
style

Note: Static text labels for the description, authors, snapshot version, document status, and last modified
date use the Requirement Label character style.

Youmay want to add content, such as a logo or legal statement, to the cover page in your template. Static
text or images you add are always included in exported documents and do not change between exports.

Snapshot history

All templates include a Snapshot History section, which displays the number, Created By, Created Date,
Label, and Comment information for each snapshot version.

The Snapshot History section has a heading, which you canmodify. The Requirement Snapshot History
Header paragraph style is applied to it. The snapshot history table uses an 8pt Arial font and cannot be
changed in the template. If you want to change the table appearance, you canmanually modify it after each
export.

If you do not want to include the snapshot history in exported documents, delete theMWE_TEST_TRACK_
RMDOC_SNAPSHOT_HISTORY bookmark from the template.
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Table of contents

All templates except Plain include a table of contents, which is automatically generated during each export.
The table contains three heading levels, which aremapped to text in the exportedWord document with the
Requirement Level 1-3 paragraph styles applied. The TOC 1-3 paragraph styles are applied to the text in the
table.

You can add levels to the table of contents or change how headings aremapped to styles. Click the
References tab and choose Table of Contents > Insert Table of Contents. In the Table of Contents dialog
box, you can specify the number of levels to display. Click Modify to select the style for new levels you add.

The templates only include styles for three heading levels. If you add levels to the table, you need to update
the corresponding style to match the other styles used in the table. Click Options to change the style
mappings used in the table.
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If you insert manual page breaks in an exported document or make other content changes that affect the table,
you need to update it. Right-click the table and chooseUpdate Field.

Requirement information

Themain body of the exported document contains requirements. Requirement tags and Summary field values
are used for requirement heading text. The Requirement Level 1-9 paragraph styles are applied to each
heading, depending on the hierarchy in the document. For example, the Requirement Level 1 style is applied
to the top-level requirements in the document and the Requirement Level 2 style is applied to immediate
children of the top-level requirements.

Text from the requirement Description fields is formatted using the Requirement Body 1-9 styles, also
depending on the document hierarchy. Any text, table, or image formatting applied to the requirement
description is maintained when it is exported, whichmeans requirements look the same in the exported
document as they do in TestTrack.

Multi-line text field values from TestTrack are displayed first in each requirement section of the exported
document. The Description field label is not displayed, but other field labels are. The Requirement Multiline
Label style is applied to the field labels and the Requirement Body style is applied to the field values.
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Single-line text field values, such as Importance and Status, are in separate paragraphs after multi-line text
values. The Requirement Label style is applied to the field labels and the Requirement Field style is applied to
the field values.

In the BasicIndented and BasicIndentedColor templates, requirements are indented to reflect the document
hierarchy. Requirements are not indented in the BasicLeftAligned and Plain templates. To adjust indentation
for a paragraph style, click Format in theModify Styles dialog box and chooseParagraph. Make any
changes on the Indents and Spacing tab.

Section breaks

All templates except Plain use section breaks to start sections on odd-numbered pages for double-sided
printing. The breaks are also used to apply different page numbering to sections.

To view section breaks, click theView tab and click Draft in the Document Views area. You can add or delete
section breaks in your template, but you need to adjust page numbering and print layout settings after making
changes.

Page footers

All templates except Plain have page footers, which contain the requirement document name and page
numbers. Footer text is formatted using the Requirement Footer paragraph style.

Footers are slightly different for each section in the templates. The cover page and snapshot history sections
do not have footer text. The table of contents section uses lowercase Roman numeral page numbers. The
requirements section starts on page 1. The document name replaces aWord field in the footer.

To change a footer, double-click the footer area on a page.

Preview and save your modified template
When you finishmodifying the template, perform a test export from TestTrack and use the template to
preview the changes. Youmay need to continuemodifying and exporting until the resulting document looks
exactly as you want.

Save the final template in a safe place, such as in your source control application. Make sure users who need
to export documents have access to the template.

Paragraph styles
The following paragraph styles are used in the installedWord templates to format requirement, document, and
table of contents text.
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Style Applied to: Notes

Requirement
Body 1-9

Text exported from
the requirement
Description field

Used primarily for paragraph spacing and alignment because text is
exported as it is formatted in TestTrack.

Requirement Body 2-9 are based on Requirement Body 1. Changes
to Requirement Body 1 are also applied to the related styles.

Left aligned in the BasicLeftAligned and Plain templates. Indented
based on hierarchy levels in the BasicIndented and
BasicIndentedColor templates. Up to nine document hierarchy levels
are supported. Requirements beyond 10 levels use the Requirement
Body 9 style.

Requirement
Document
Description

Text exported from
the document
Description field

Used primarily for paragraph spacing and alignment because text is
exported as it is formatted in TestTrack.

Requirement
Document
Title

Text exported from
the document
Name field

Formats the document title on the cover page.

Black in the BasicIndented and BasicLeftAligned templates. Blue in
the BasicIndentedColor template. Not used in the Plain template.

Requirement
Footer

Footer text and
page numbers

Not used in the Plain template.

Requirement
Fields 1-9

Requirement fields
(e.g., Status,
Importance)

Up to nine document hierarchy levels are supported. Requirements
beyond 10 levels use the Requirement Fields 9 style.

Requirement
Level 1-9

Text exported from
the requirement
Summary field
(heading for each
requirement)

Numbering is based on the hierarchy of requirements in the
document. Up to nine levels are supported.

All requirements beyond 10 levels use the Requirement Level 9
style. Left aligned in the Plain and BasicLeftAligned templates.

Indented based on hierarchy level in the BasicIndented and
BasicIndentedColor templates.

Requirement
Snapshot
History
Header

Snapshot History
section title

Black in the BasicIndented and BasicLeftAligned templates. Blue in
the BasicIndentedColor template. Not used in the Plain template.

Requirement
TOC Header

Table of Contents
section title

Black in the BasicIndented and BasicLeftAligned templates. Blue in
the BasicIndentedColor template. Not used in the Plain template.

TOC 1, TOC
2, TOC 3

First three levels in
the table of
contents

Not used in the Plain template.
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Character styles
The following character styles are used in the installed templates to apply inline formatting to requirement and
document field labels.

Style Description

Requirement
Document Name

Formats text from the document Name field, which is exported as the document title
on the first page in the Plain template.

Not used in the BasicIndented, BasicIndentedColor, and BasicLeftAligned
templates.

Requirement
Document
Snapshot Version

Formats text after the Snapshot Version: label on the cover page of the
BasicIndented, BasicIndentedColor, and BasicLeftAligned templates or first page of
Plain template.

Requirement
Document Status

Formats text after the Status: label on the cover page of the BasicIndented,
BasicIndentedColor, and BasicLeftAligned templates or first page of Plain template.

Requirement Field Formats text after field labels in requirements (e.g., Status, Importance). Also
formats text after static labels on the cover page, such as the last modified date.

Requirement Summary and Requirement Tag character styles are based on this
style.

Requirement Label Formats static labels on cover pages (e.g., Description, Authors, Snapshot Version)
and single-line field labels in requirements (e.g., Importance, Status).

Requirement
Multiline Label

Formats multi-line text field labels in requirements (e.g., Source Files and custom
multi-line text fields).

Requirement
Summary

Formats text from the requirement Summary field in the heading for each
requirement.

Based on Requirement Field character style.

Requirement Tag Formats the requirement tag in the heading for each requirement.

Based on Requirement Field character style.

13


	Modifying Microsoft Word Templates for TestTrack Requirement Document Exports

